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Les tableaux dans Pages.

Un tableau, pour quoi faire?

Entrer des données et éventuellement les trier.
Vous pouvez créer un tableau depuis:
e L'outil tableau.

e Le menu insertion > tableau.
e Un tableau créé avec Word.

Ajoutez I'outil tableau a la barre d’outils.

Ry Partager tenetre  Aide Si vous créez souvent des tableaux dans Pages, ajoutez
Inspecteur > I'outil tableau dans la barre d’outils.
Afficher les vignettes de page X &P k
Afficher | bre d . .
e o Pour personnaliser la barre d’outils allez dans le menu
Guides > Présentation > personnaliser la barre d’outils >
Afficher la mise en page %L faites glisser I'outil tableau dans la barre d’outils.
Afficher les caractéres invisibles {88l
Commentaires et modifications >

Afficher les outils de disposition
Afficher les couleurs 0 8C
Afficher Ajuster I'image

Agrandir/réduire >
Afficher les avertissements

Activer le mode plein écran ~%F
Masquer la barre d'outils 8T

Personnaliser la harre doutils...

I —

@ Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
L ] 7 rampe85.pages
&  125%v OB Al A+l A-ll O BT~ T | = v @ a B

Imprimer  Zoom Tableau ntation Polices Plus grand Plus petit Couleurs Insérer Texte Donné édias C Partager Indices Recherche Fc

Pages

Faites glisser vos élé favoris dans la barre d'outils...
— = e '
[ R v «il J s (sl = hv 2 B
Présentation Zoom Insérer Tablcab‘ Graphique Texte Figure Données multimédias Commentaire Partager Indices Format Document
" .,
. i . . [ = &  Eg A+ A- A A |
Plan supérieur Plan inférieur Devant Derriére Retournement horizontal Retournement vertical Grouper Dissocier Plus grand Plus petit Exposant Indice
IS = i # & =) B 3 %= Aa ©
Désindenter Indenter Suivi des modifications Guides Copier le style Coller le style Masquer Alpha instantané Verrouilier Déverrouiller Polices Lien
PN Q = o \ - -’1

Aluster I'image Recherche Imprimer Couleurs Espace Espace ajustable

5 ... ou faites gli: 1% ble par défaut sur la barre d'outils.
8- g e al T = = = hv @ B
Présentation Zoom Insérer Tableau Graphique Texte Figure Données multimédias Commentaire Partager Indices Format Document

Afficher  Icone et texte B
L — T
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Tableau

? *

Pour créer un tableau, positionnez-vous dans votre page, cliquez sur I'outil tableau et
choisissez un modele de tableau.

__® rages ricnier

Styles de tableau
o

En-tétes et bas de tableau
(B 13 (B 13 (= 03]
[} Nom du tableau

(ﬁ\:msun-gl

Taille de la police du
tableau AsimA

1 — T

Pages insére un tableau selon le modéle que vous avez choisi.

Rampe de Lancement 85 Pages pour OS X Page 8



Créer un tableau depuis le menu insertion.

W Pages richier taiion guicgi-ugy Format  Uisposition  Fresentation rartager renetre  Aide
@00 Section Sans titre — Modifie

. % | Saut de section

Tableas PH gaut de page
Saut de colonne

Numéro de page
Nombre de pages
Tableau Date et heure

Table des matiéres
Note de bas de page

Craphique > Standard
Zone de texte Standard
Figure > Sommes
Ligne > |
Surligner £ 8H
Commenter 38K

(e BE—

W rages ricnier  cdiion  INseruon  rofmat  Uisposition  kresentalion  rariager renetre  Alge
@006 Sans titre — Modifié %l

‘ - y " g O 0

! A B c D ) H _!_
d S S
2 { ‘ | Styles d.e tableau
3 o .
4 ‘ En-tétes et bas de tableau
j’ 4 | (BB 13 (B 1% (= 03]
= T [ Nom du tableau
T — B

Vous pouvez aussi créer un tableau depuis le menu insertion > tableau > sous-sections ou
autres modéles situés dessous.
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Créer un tableau tout simple.

@ Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide

[ NN 7| rampe85.pages — Modifie
& 125%- B2 DO~ Aal A+ A-] Q9T T = v
Imprimer _ Zoom Tar ~au Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Données multimédias Commentairs Partager

Proserison  Zoom badewr  Tiblms Gaohige Teos Tgew Oonvees mutmeces Commentaee  Partager edces amat Oocumem

. Ou faites ghisser I'ensembie par défaut sur la barre doutis.
,,]---- [0 - s - = 4 7 8 = = 6 o ENB
v ¥

| 1 O o [N e
1 P— T
. | | S | -- .ancement 85 Pages pour OS X Page 6
]
F
(@) A B c D [
2
1
i t‘l 2
3 L
- 4 |
3 5
o . o
’ ‘

Parmi les modéles il y a un modéle de tableau tout simple de 4 colonnes X 5 lignes.

Rampe de Lancement 85 Pages pour OS X Page 10



Ouvrir un tableau depuis un document Microsoft Word.

® Pages [ tdition Insertion  Format
® 00 Nouveau... 3N

e ———
0,060 - ~ Ouvrir
| < >v||SSE[]J] imi || =~ || & Macintosh HD )
(] Dropbox Nom B
%‘, Tous mes fichiers » [ rampe70
#% Calculette.app » [ rampe71
/\ Applicati » (] rampe72
! ppAEAtions » [ rampe73
[l Bureau v [ rampe74

Images F fichier-indexation-excel.docx

@ yvescornil @ rampe74.docx

rampe?74.jpg

R —
@ Pages Fichier Edition Insertion Format Disposition Pré ion Partager Fenétre Aide
Il est possi b | e [NsNa) fichier-indexation-excel [l
; =[x i " i =
d’ouvrir un doc- mpnme_zoom &N‘;ﬂﬂgﬂm.ﬁi ;mé;ﬂ‘_ém @%E_w!vflm E"‘S‘?fﬁ"ﬁ‘i Commentie_ :‘hglw kgs wg«}* =
ument Word qui
contient un I
Lo ’
ta b I eau ! ICl C eSt .doc Document Word
u n ta b I ea ua SseZ .doex Document Word
i m po rta nt, q u | .exe Programme exécutable
évitera la saisie ot RESISEDE
d’un tableau de - =
plusieurs pages v Bomeolt
I 0 rs d es eXe rci Ce s Xls Document Excel
p rath ues réa I | SéS ,xrlsx Document Excel
| ors d e I la te I I er z(::tivaﬁon :::::::on
Pag es d u C I | a C . administrateur Administrateur A s
adresse Adresse Sélectionnez I'objet ou Ie.xexte a
mettre en forme.
adresse ¢lectronique Adresse électronique
ajuster la taille des cellules Ajuster la taille des cellules
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Insérer une ligne au-dessus.

o) | A | B ()
g T
l J -doc Répéter les rangs d'en-téte sur chaque page
2 -
.docx Irsérer un rang au-dessus
3| | .exe Insérer un rang en dessous
4| | .pdf Insérer une colonne avant
& Insérer une colonne aprés
pps
6| | ppsx Supprimer le rang
Supprimer la colonne e
R — B ———
Q)| A B )
i I
Eve -
2 | .doc Document Word
3 | .docx Document Word
R — R

Pour insérer une ligne, positionnez-vous dans une cellule, un clic droit > insérer un rang
au-dessus.

W rages ricnier caion Inseruon rormat  UIsposilion  rresentalion rartager renetre Ailde

800 fichier-indexation-excel — Modifié 2

Cellule Texte Disposition
o) | B I BiI=== I iﬁl
_ - | = = e |
‘ 1 ‘ ‘ mot a indexer I[Index
= .
2 | .doc Document Word | l I
1 l |
3 | .docx Document Word [ ] [ |
4| | .exe Programme exécutable Styles de tableau
.
5 | .pdf Document PDF
3 En-tétes et bas de tableau
6 | .pps PowerPoint
. (BB 04| (M 14| (E8 0%
7 | .ppsx PowerPoint
: [} Nom du tableau L
8 | .ppt PowerPoint
9| | xls Document Excel Taille de la police du (&) a)
tableau I
10 | xlsx Document Excel
R — e EEEE——_

Vous pouvez aussi insérer un rang en dessous ou une colonne, a droite (apres) ou a
gauche (avant).
Vous pouvez aussi supprimer une ligne (rang) ou une colonne depuis le clic droit.
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Dans le vocabulaire de Pages une ligne s’appelle un rang.

Saisie dans une cellule.

® A B 1l
O
1| | mot a indexer N
‘ : ol
2 | | .doc Document Word
3 | | .docx Document Word
L — T

Pour saisir une donnée positionnez le curseur dans la souris dans une cellule et saisissez
vos informations.

Définir une ligne de titre.

W rages ricnier caiuon Inseruon  rormat  LIsposilion  rresentauon rartager renetre  Alge

800 fichier-indexation-excel — Modifié e
S @) EH 0 Aa A+ a- O B T OB E ul (@ Ol
Imprimer Zoom Tableau Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Données multimédias C i ger Indices Recherche

Cellule Texte Disposition
[

[ ] A [:} 1l — I E
1| || mot a indexer index
| T
2| | .doc Document Word
3 | .docx Document Word
4| | .exe Programme exécutable '
5| [.pdf Document PDF
- En-tétes et bas de tableau
6 | .pps PowerPoint pRp— J—
|EB o35 voO (B 03]
7 | .ppsx PowerPoint o
[ INomdutab N
8 | ppt PowerPoint 3
Tailledelapa 4 ™
9
Xls Document Excel et : [ a | A]
107 | xlIsx Document Excel E—
L — N

Pour définir une ligne de titre, positionnez-vous dans une cellule de la premiere ligne et
cliquez sur I'outil en-téte et bas de tableau et dans le menu déroulant choisissez le nombre
de lignes a prendre en compte.

Dans le vocabulaire de Pages la ligne de titre s’appelle rang d’en-téte.
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Répéter le rang d'en-téte sur chaque page.

® rages ricnier

caion

inseruon _rormat

LIsposilion _ kresentation _rartager

renetre  Aige

[ NeNa]
=[x

fichier-indexation-excel — Modifié

e | A | B Uy
o Ll
‘j I mot & indaxer Répter les rangs d'en-téte sur chaque page
2
{ idoo Insérer un rang d’en-téte au-dessus
3 | .doex Insérer un rang d’en-téte en dessous
4| |.exe Insérer une colonne avant Stylaxics iblen
s || pdf Insérer une colonne aprés
e | pps Supprimer le rang En-tétes et bas de tableau
= Supprimer la colonne (B o4 (BB 14| |EH 02
—~— ——————
23 | ascenseur Ascenseur
24 | attributs d’un texte Attributs d’un texte
25| | barre de menus Barre de menus
26| | barre de taches Barre de tiaches
27| | barre latérale Barre latérale
28 | barres d'outils Barre d’outils
29 | bas de page Pied de page
30 | boite d’envoi Boite d’envoi
( A | B
m mot a indexer index
.
31 | boite de réception Boite de réception
32 | Boot Camp Boot Camp
33 | BootCamp Boot Camp
34 | bordure Bordure

Si vous avez de longues listes, répétez la ligne d’en-téte.
Cliquez sur la premiére ligne, un clic droit > répéter les rangs d’en-tétes sur chaque page.
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Trier une colonne.

¥ Pages richier tdituon Insertuon rormat Lisposition Fresentation Fartager renetre A

® 00 fichier-indexation-excel — Modifié
o [1zsx -] i1 Aa A+ a- O i - E
[Imprimer  Zoom Tableau Présentation Polices Plus grand Pius petit Couleurs Insérer Texte Données multimédias Comme

o)l Trier en ordre cr sant I

£ ’ ot Wdakei Trier en ordre décroissant

2 | .doe Insérer une colonne d'en-téte avant

Convertir en colonne d'en-téte
3 2
-doex Insérer une colonne avant

4| | .exe Insérer une colonne apreés

5 | .pdf Supprimer |la colonne

6| | .pps Aiuster la largeur au contenu

L — R

Dans Pages vous pouvez trier une colonne en ordre croissant ou en ordre décroissant.
Cliquez sur le colonne, tout en haut, un clic droit > trier en ordre croissant ou en ordre
décroissant.

Le vocabulaire de Pages.

®Une ligne = un rang.

®|igne de titre = rang d’entéte.
® Avant = a gauche.

® Apres = a droite.

Ajouter des lignes en fin de tableau.

344 | WPA WPA
5 | XPS XPS
346 | zip Compression
347 | zoom Zoom
357 (K
— e E———_—
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Pour ajouter une ligne en fin de tableau, cliquez sur le petit rond situé en bas a gauche du
tableau pour faire apparaitre un compteur; cliquez sur le triangle du bas pour ajouter des

lignes, sur le triangle du haut pour diminuer le nombre de lignes (rangs).

347

1360 (2]
it

zZoom

Zoom

51

352

353

354

355

356

357

358

358

360

Rampe de Lancement 85
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Ajouter une colonne dans un tableau.

o) B ] 2 @‘
1 | mot a indexer index
2| | .doc Document Word

| 3| | .docx Document Word

: 4| | exe Programme exécutable

Pour ajouter une colonne a droite, cliquez dans le petit rond, en haut a droite puis sur le
petit triangle du bas pour ajouter des colonnes, sur le triangle du haut pour en supprimer.

(@) A B c \ 3 (&
1 | mot a indexer index
2 | | .doc Document Word
3 | .docx Document Word
4 | .exe Programme exécutable
5 |.pdf Document PDF
6 nne PawarPaint
I Cellule  Texte Disposition
1 | |
e a 8 S EEE. | -
Trier en ordre croissant
1 | mot aindexer Index Trier en ordre décroissant
‘ 2| | .doc Document Word Insérer une colonne avant =
3| | doex Document Word Insérer une colonne aprés =
4| | exe Programme exécutable Supprimer la colonne frolent
5 |.pdf Document PDF Ajuster la largeur au contenu {
leau
6 | .pps PowerPoint Importer une image N
[ : Capturer la sélection de I'écran ,}_'J [M|
ppsx PowerPoint
8 nnt PoawerPaint j
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Vous pouvez aussi insérer une colonne a l'intérieur d’un tableau; positionnez-vous dans
une colonne, un clic droit > et choisissez insérer une colonne avant ou une colonne aprés
la colonne ou vous étes positionné.

Insérer une colonne a droite.

® [ A F T
— Trier en ordre croissant

1 | mot & indexer index  Trier en ordre décroissant
2 | doc Docur Insérer une colonne avant

3| | docx Docu Insérer unolonne apres

Supprimer la colonne

4| | .exe Progr:
5| | .pdf Docur Ajuster la largeur au contenu
6 | .pps Power Importer une image
Capturer la sélection de I'écran
7 | .ppsx Powel....... -
8 | .ppt PowerPoint
R — ————

Pour insérer une colonne a droite, positionnez-vous dans une colonne, un clic droit > in-
sérer une colonne apres.

e A v 8 . c N
1 | mot a indexer index
2| .doc Document Word
3 | | .docx Document Word
4| | -exe Programme [N
executable
5| | .pdf Document PDF
6 | .pps PowerPoint
7 | .ppsx PowerPoint
10— e ———
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Supprimer une colonne.

O ey, e ¢ IENE
1 | mot aindexer index
| 2| | .doc Document Word
| 3 | | .docx Document Word
| 4| | .exe Programme exécutable
5| [ .pdf Document PDF
6 | .pps PowerPoint
| 7 | .ppsx PowerPoint
| 8 | nnt PowerPoint
T — ————————

O : I - < ordre croissant 136
11 lisodik inidiss Trier en ordre décroissant
2 doc - Insérer une colonne avant
Insérer une colonne aprés
3 | .docx 3
' Supprime< |a colonne
4| | exe ‘
' - Ajuster la largeur au contenu
5 |.pdf
' R . Importer une image
, PP Capturer la sélection de I'écran
0 — S

Pour supprimer une colonne, sélectionnez le colonne, un clic droit > supprimer la
colonne.
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Modifier la largeur d’'un tableau.

e} A B Il
1 | mot a indexer index

2| | .doc Document Word

3 | |.docx Document Word

4| | .exe Programme exécutable

5| | .pdf Document PDF

6 | .pps PowerPoint

Vous pouvez ajuster la largeur d’'une colonne selon vos besoins; positionnez-vous entre 2
colonnes et déplacez I'outil double fléches et déplacer a droite et a gauche.

|

i

—
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Pour ajuster la largeur des cellules, amenez avec votre souris sur la limite de séparation
des cellules. La fleche se transforme en double fleche.

Décalez cet outil a droite ou a gauche pour modifier la largeur des cellules.

C’est le méme processus pour modifier la hauteur d’une ligne de cellules.

Ajuster la largeur d'une colonne au contenu.

cuaun i uvn fulitat LIDpUSILIVEE riecociiianivie raitayci reicuc Aiuc

|9 fichier-indexation.pages — Modifié

Trier en ordre croissant

mot a indexer inde Irier en ordre décroissant

2 || .doc Doc Insérer des colonnes avant
Insérer des colonnes aprés |

3 | .docx Doc P

| | sexe Prog Supprimer |les colonnes sélectionnées

5 | pdf e Ajuster la largeur au contenu

6 | .pps Pow Importer une image _—_I
Capturer la sélection de 'écran

7 | .ppsx POoWesn

8 || .ppt PowerPoint

1 | mot a indexer index
2 |l .doc Document Word
3 || .doex Document Word
| 4| .exe Programme exécutable
5 || pdf Document PDF I
6 | .pps PowerPoint
7 || .ppsx PowerPoint
R — ——

Vous pouvez ajuster la largeur des colonnes au contenu.
Sélectionnez le tableau (tout en haut), un clic droit > ajuster la largeur au contenu.
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Répartir uniformément les colonnes.

|
_ Gg— 3 , A
- v Répéter les rangs d'en-téte sur chaque page

Répartir les rangs uniformément

1
Répartir les colonnes unifrmément

i Placer au premier plan

4‘ Placer a l'arriere-plan

€
¢ Aligner les objets >
Répartir les objets >
€
- Couper
1 Copier
¢ Coller

' Tout effacer
£
Importer une image

| , . P
: Capturer la sélection de I'écran

e TN L ol

T —

e —

Vous pouvez répartir la largeur des colonnes uniformément; cliquez dans une cellule, un

clic droit > répartir les colonnes uniformément.

&) A e I
1 | mot a indexer index

2 | | .doc LN Document Word

3 | | .docx Document Word

| 4 |.exe Programme exécutable

5 | .pdf Document PDF

| 6 | .pps PowerPoint

7 | .ppsx PowerPoint

8 | .ppt PowerPoint

9 | xls Document Excel

10] | xIsx Document Excel
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Fusionner des cellules.

Pour fusionner les cellules : sélectionnez plusieurs cellules, puis choisissez Format >
Tableau > Fusionner les cellules (dans le menu Format situé en haut de I'écran d’ordi-
nateur).

La fusion de cellules aboutit aux résultats suivants :

Si, avant la fusion, seulement une des cellules contient des données, la
cellule fusionnée finale conserve le contenu et la mise en forme de cette cellule.

Si, avant la fusion, plusieurs cellules contiennent des données, tout le
contenu est conservé, mais les cellules comportant un format de données spécifique,
comme des nombres, des devises ou des dates, sont converties au format texte.

Si une couleur de remplissage est appliquée a la cellule supérieure
gauche, la cellule fusionnée reprend cette couleur de remplissage.

@ Pages Fichier Edition Insertion JLCIGE Disposition  Présentation  Partager Fenétre  Aide

10 06 Police » |— Modifie =l
- —_— = — Texte > ?
= N Frrr P == I | E T u e Q ,
Imprimer Zoom Tableau Présentation Pg Tableau S Insérer un rang au-dessus [’ Indices Recherche
Craphique > Insérer un rang en dessous lle Texte Disposition
Figures et lignes > S |
Image > nsérer des colonnes avaflt
e Vidéo > Insérer des colonnes aprés
o A 8 :
Copier le style X #8C Suppr{mer le rang
1 Coller le stvle \C 38\, Supprimer les colonnes
2 Rangs d'en-téte >
2 T Siinbrimerdalien v Répéter les rangs d'en-téte sur chaque page
Il Colonnes d'en-téte >
rl Avancé > Rangs de bas de tableau > .
T
5 Ajuster le rang au contenu \s de tableau
= (B o: (EB o3:
Répartir les rangs uniformément -
Répartir les colonnes uniformément
Remplir automatiquement les cellules p licedu ] A
Fusionner les cellule
ableau
Inverser la direction du tableau O 0250
| — ——
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Tableau

Ici des cellules au centre du tableau ont été fusionnées.

Dissocier des cellules.

Sélectionnez la cellule, puis choisissez Format > Tableau > Ne plus fusionner les
cellules (le menu Format se trouve en haut de I'écran).

Tout le contenu des cellules qui étaient fusionnées apparait dans la premiere cellule
scindée.

Vous pouvez aussi passer par le menu Format > Tableau > ne plus fusionner les
cellules.

® Pages Fichier Edition Insertion WJGE Disposition Présentation Partager Fenétre Aide

8006 Police > — Modifié %
= e > -
=) [125%-] I e b T Ln =l O] Q
Imprimer Zoom Tableau Présentation 2 Tableau > Insérer un rang au-dessus r Indices Recherche
Graphique > Insérer un rang en dessous lle Texte Disposition
Figures et lignes > ,
Image > Insérer des colonnes avant
e Vidéo > Insérer des colonnes aprés
) A -
Copier le style X 8C Supprfmer le rang
1 Coller le stvle 88V Supprimer les colonnes
2 Kiouter an.liaq s8K Rangs d'en-téte > -
z Stinprmer e fan v Répéter les rangs d'en-téte sur chaque page
Colonnes d'en-téte P B da tables
4 Avancé > Rangs de bas de tableau > .
li
§ Ajuster le rang au contenu is de tableau
Ajuster la colonne au contenu — - -
= B os| |EH 03]
Répartir les rangs uniformément -
Répartir les colonnes uniformément
Remplir automatiquement les cellules p licedu Al A
Fusionner les cellules
Ne plus fusionner les cellules
ableau
Inverser la direction du tableau'] Bl [0
L — —————
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Une autre possibilité c’est de passer par un clic droit > ne plus fusionner les cellules.

m Cellule | Texte  Disposition

e T a 8 c D I
1
5 o o o il
"a" I 2 ([ 7 B ¥
= v Répéter les rangs d'en-téte sur chaque page Styles de tableau
4 .
! - Insérer un rang au-dessus E
. _ Insérer un rang en dessous | En-tétes et bas de tableau
= Insérer des colonnes avant (BB o4| [ of | 04|
Insérer des colonnes aprés ) Nom dw tableats
Supprimer le rang TR
. allle de |12 police du T
Supprimer les colonnes S [alA]
Fusionner les cellules
Ne plus fusionner les cellules .
N Structure du tableau
Couper [—— ¢ O] [0.25 pt|(})
Copier R
Coller ("] Nom du tableau en relief
Tout effacer
v Ajuster le texte Quadrillage
T ¥
Importer une image [ E5-|-HH ] [ e =l
Capturer la sélection de I'écran
¥ Couleur en alternance | 0|
e — R
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Les outils des tableaux.

(s} % execicetableaucilac.pages e

(a}
2 @m0 As Ar a- O @ T p & u © e |

Cellule  Texte Disposition

Tableau des activités du CILAC.
oAl & [ ¢ ] ) I E )
:
(1] T Semaine 20 X l
13/05  mardi 14h30 4 16h30 Appareil photo numérique 2, utilisation, Josette
2 réglages
Styles de tableau
! | .o
3 14/05 mercredi | 09h30 & 11h30 | Ininiation Thérése - Luc
4 14/05 mercredi  14h30a16h30 Apple - le Pages qui te plait Yves En-tétes et bas de tableau
! ! | (B of| [ ot [EH 0%
5 15/05 mercredi | 14h30 & 16h30 Initiation utilisation iPad sous iOS 7 Yves

) Nom du tableau

6 1505 jeudi 17h00419h00  ASSEMBLEE GENERALE DU CILAC - :;'l';:‘ Sgrlmen (ala]

Structure du tableau

(——:| WO o253

(] Nom du tableau en relief

Quadrillage
[T=r TN D)

[ Couleur en alternance | (6]

¥ Tailles des rangs et colonnes
—@
Rang: T [0,71cni[:) |Adapter
Colonne: *+ 1,38 cn‘@ | Adapter |

@Ajuster les rangs au contenu des cellules

R — R

Quand vous cliquez dans un tableau un panneau s’affiche a droite.

B Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
8006 |# execicetableaucilac.pages — Modifié e

o [zs% ] B [ Aa A+ a~- O E T Ln = Su e Q 5

Tableau Texte Disposition
Format des données
Tableau des activités du CILAC. | v Automatigue
(A B c D I ) g
e L L I E (1 Nombre ‘
1| ' Semaine 20 Devise
- - ; : Pourcentage |
13/05  mardi | 14h30 & 16h30 | Appareil photo numérique 2, utilisation, Josette Fraction '
2 réglages Systéme numérique E
| | | | Scientifique J
3 14/05 | mercredi 09h30 & 11h30 | Ininiation Thérese - Luc Texte |
4 14105 mercredi  14h30 a 16h30 Apple - le Pages qui te plait Yves
Date et heure
| s | | R 07 g 2 | Durée
5| 15/05 | mercredi | 14h30 a 16h30 | Initiation utilisation iPad sous iOS 7 Yves |
3 Créer un format personnalisé...
6 15/05  jeudi 17h00 4 19h00 ~ ASSEMBLEE GENERALE DU CILAC 3pt @ -§J ]
f ) Choisissez un style de bordure puis
cliquez sur un motif.
Surlignage conditionnel...

Rampe de Lancement 85 Pages pour OS X

Ici depuis
l'onglet
cellule on
peut don-
ner un
format aux
cellules.
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B Pages Fichier Edition |Insertion Format Disposition Présentation Partager Fenétre Aide
® 006 |# execicetableaucilac.pages — Modifié v

-

Tableau Cellule Texte Disposition

Format des données

Tableau des activités du CILAC. | Automatique :
e A [ B | c B D I E )
1| ' Semaine 20
13/05 | mardi ' 14h30 & 16h30 Appareil photo numérique 2, utilisation, Josette - Damnllecans —
2 reglages ; Aucun remplissage
| | | | | : ¥ Remplissage couleur g
3 14/05  mercredi | 09h30 & 11h30 | Ininiation Théreése - Luc Remplissage dégradé
T T T Z I Remplissage dégradé avancé
4| 1405 mercredi  14h30 a16h30 Apple - le Pages qui te plait Yves Remplissage par image '
| I ] { ‘ Remplassage image avancé
5|  15/05 | mercredi 14h30 a 16h30 | Initiation utilisation iPad sous iOS 7 Yves |
L | | | Q
l A O
6| 15/05  jeudi | 17h00 2 19h00  ~ ASSEMBLEE GENERALE DU CILAC 3pt @ -@ I
=

(n

Choisissez un style de bordure puis
cliquez sur un motif.

| Surlignage conditionnel... |

B Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
006 |#] execicetableaucilac.pages — Modifié ¥

Tableau Cellule Texte Disposition

Format des données
Tableau des activités du CILAC. | Automatique A

e A [ B | c ] D I E ()

1 Semaine 20

13/05 | mardi ' 14h30 & 16h30 Appareil photo numérique 2, utilisation, Josette ¥ Remplissage

2 réglages P g -
[ | | | | i | Remplissage dégradé 3]
3 14/05 <mercredi | 09h30 a 11h30  Ininiation Thérése - Luc -3 @
4 1405 mercredi  14h30 4 16h30 Apple - le Pages qui te plait Yves D Angle: [

5| 15/05 'mercredi | 14h30 & 16h30 | Initiation utilisation iPad sous IOS 7 Yves L3
e q ¥ Bordure ‘ & ’
6 15005 | jeudi | 17h00419h00 ~ ASSEMBLEE GENERALE DU CILAC ' Y (mo

= BETIE]  [ONISE

Choisissez un style de bordure puis
cliquez sur un motif.

| Surlignage conditionnel... |

Ici remplissage en couleur d’'une cellule.
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B Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
8080 |# execicetableaucilac.pages — Modifié ")
— T
=[x B O Aa A+ a~- O E T 7] S @) Qe
e L) Tableau Présentation Polices Plusgrand Pluspetit Couleurs Insérer Texte Donnéesmultimédias Commentaire Partager Indices Recherche
ercher
Format des données 'y
Tableau des activités du CILAC. | Automatique A
() A B c D E 1l
1 Semaine 20
13/05 = mardi 14h30 & 16h30  Appareil photo numérique 2, utilisation, Josette ¥ Remplissage
: oot plissag ]
| Remplissage dégradé &
3| 14/05 mercredi | 09h30 a 11h30 | Ininiation Thérese - Luc -§] T’T‘
4 14/05 mercredi  14h30 a 16h30 Apple - le Pages qui te plait Yves 3 Angle : | ) —
5 15/05  mercredi 14h30 & 16h30 | Initiation utilisation iPad sous iIOS 7 Yves
Q ¥ Bordure ‘ A‘& ‘ L
6 15/05 jeudi 17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC | e— T
Choisir un style de bordure :
- —_— patii i on S O
3pt [ 3
Appliquer le style a :
Choisissez un s|
cliquez E D
| Surlignage | |
~ Réinitialiser |
—_———
L — L e

Depuis I'outil bordure de I'onglet cellule vous pouvez appliquer un style a une bordure.

Tableau des activités du CILAC.

Tableau  Cellule

Placement d'objet

Ajustement du texte

\ Rester sur la page Avec Ig texte

| a_ Incorporé au texte

Espacement

Position

Alpha

i | ||

Arriére Avant

Aligner v Répartir

Taille

Plan inf. Plan sup.

[16,47 cm[%] [ 6,82 cm|3]
Largeur Hauteur

Conserver les proportions

Position

Faire pivoter

Angle

Verrouiller

Regrouper

L) A B c D E I
1 ' Semaine 20
13/05  mardi 14h30 a 16h30 | Appareil photo numérique 2, utilisation, Josette

2 réglages
1 3 14/05 | mercredi | 09h30 a 11h30T Ininiation lThérése -Luc

4 14005 mercredi  14h30 a 16h30 Apple - le Pages qui te plait Yves

5 15/05 | mercredi 14h30 & 16h30 | Initiation utilisation iPad sous iOS 7 Yves

6 15/05 | jeudi 17h00 & 19h00 ASSEMBLEE GENERALE DU CILAC -

R —

Miroir

Déverrouiller

Dissocier

Depuis I'onglet texte vous pouvez choisir une police, taille, gras, italique, etc.

Vous pouvez aussi choir un espacement entre lignes, changer I'alignement, etc.

Rampe de Lancement 85

Pages pour OS X
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Les modeles de Pages.

Modeéles proposés par Pages.

Au lancement de Pages ou quand vous créez un nouveau document vous avez acces a
plusieurs modeles qui sont classés par grands themes.

Vierge Vierge - Paysage Prise de notes

Standard.

Reportage Dissertation Rapport scolaire Exposé Publication de recherche Rapport moderne Proposition de projet

Rapports.

AFNOR Lettre classique Lettre moderne Lettre professionnelle Lettre traditionnelle Lettre avec photo Lettre élégante

Lettre en gras Lettre informelie

Lettres.

Enveloppe classique Enveloppe moderne Enveloppe Enveloppe élégante Enveloppe en gras Enveloppe informelle
professionnelle 2

Enveloppes.
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Urna
Semper

Curriculum Vitae CV classique CV moderne

CV professionnel

CV élégant

CV en gras

Urna
Semper

Curriculum Vitae CV classique CV moderne

CV professionnel

Divers.

CV élégant

CVen gras

Cartes de visite classiques Cartes de visite modernes Cartes de visite

ET IPSUM

Lorem Ipsum Dolor:Amet
1 x5

Prospectus A louer Prospectus & tabulations

Petite affiche de Grande affiche de Petite affiche de la féte
I'événement vénement

Grande affiche d'imprimerie

Cartes de visites.

Prospectus Immobilier

51

&

LOREM, IPSUM
& DOLOR AMET

Grande affiche de la féte

Cartes de visite élégantes

LOREM ELIT

1234567090

Prospectus Perdu/Trouvé

STH

Lorem Ipsum

Petite affiche scolaire

Prospectus et affiches.

Rampe de Lancement 85

Pages pour OS X

Cartes de visite en gras

Petite affiche

Grande affiche scolaire

CV informel

CV informel

Cartes de visite informelles

Grande affiche

Untitied

Petite affiche d'imprimerie
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Carte avec photo verticale Carte avec photo Carte d'anniversaire Carte postale Immobilier Carte postale de Carte postale de
horizontale I'événement déménagement

Cartes.

Facture Dépliant élégant Dépliant - Musée

Divers.

LOREM IPSUM L e
( LOREM

pe {f i/
'~ WL

Bulletin Bulletin d’informations du Bulletin simple Bulletin serif

Bulletins.

Ala
découverte
d'Excel 2011
pour le Mac.

modéle-Rampe1 monmodelel

Mes modeles.

Dans mes modeles vous pourrez enregistrer vos propres modeéles.
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Les styles dans Pages.

Dans Pages, vous pouvez utiliser les styles pour mettre du texte en forme avec rapid-

ité et facilité.

Divers types de styles sont disponibles au départ; vous pourrez les modifier et en

créer de nouveaux.

Les styles de paragraphe définissent I'aspect du texte d'un document, au niveau du

paragraphe.

L'application d'un style de paragraphe affecte le paragraphe entier.

Les styles de paragraphe servent généralement a contréler la mise en forme générale

de grandes parties de texte.

Les styles de paragraphes servent aussi de base a la création des tables des matieres.

Les styles de paragraphe peuvent contenir toutes les regles de mise en forme des
styles de caractéres, mais controlent également I'apparence du paragraphe, y compris

Partager Fenétre Aide

Inspecteur > "/ Formater .

q Afficher les vignettes de page X #P Mise en page X

I'alignement du texte, les tabulations, l'interligne et les bordures.

Présentation Partager Fenétre Aide

»ans titre e |

| T @ @ Q )

urs Insérer Texte Données multimédias Partager Indices Recherche

courantllj

Disposition Plus !

Police 4

Rampe de Lancement 85 Pages pour OS X

On peut voir les
styles depuis la
barre d’outils
standard et
depuis l'onglet
accueil dans le
groupe styles.

Ici le style de

paragraphe est
courant11j.
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Présentation Partager Fenétre Aide Texte
Sans titre ol
) T en @i ©) Q »|
urs Insérer Texte Données multimédias Partager Indices Recherche I. COUFantll] ‘*
Texte !‘ K
courant11j v | Styles de paragraphe -+ —I
B
]
= = -
lﬂ_k Disposition Plus ‘ ! Tlt re I
"
Police "
. 4
Sous-titre "
a tpts)
_— _ L En-téte -
A droite vous pouvez voir les différents E|
styles qui existent pour ce document Sous-section 2 |
Pages. Ss-section 3
Sous-section rouge
Corps =
v courant11j t:|
Introduction |
Titre3
)
TITRE2 Ijm
1y
TITRE1 | -
D pt|l)
LEGENDE | -
En-téte, bas de page Dot /L2
Note de bas de page |
Etiquette Foncé Lj'
| Retraits|0em|[7)T 0cm |5
Puce Texte
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Création du premier style.

— e —

® Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide

® 06 Sans titre — Modifie e
=) [125% -] EH O Aa A+ a- O H T A = Mt @ Q
Imprimer Zoom Tableau Présentation Polices Plus grand Plus petit Couleurs Insérer Texte Daonnées multimédias Commentaire Partager Indices Recherche
1
Texte
-
Titre 1.

Corps* «

Titre 2

Styles de paragraphe 4 B
Maintenant je voudrais créer mon pre- -

mier style. Tit re

J'ai tapé un exemple du type de texte " -
que je voudrais obtenir (police, taille, Sous-titre E
couleur, cadrage, etc.). Le texte sélec- a bpt|ls)
tionné est attribué, actuellement, a En-téte |
Corps. = 9
P Sous-section 2 |
Je pourrais modifier corps pour qu'’il Ss-section 3 ﬁ‘
prenne les caractéristiques du texte " ‘
sélectionné en cliquant sur mise a jour Sous-section rouge 3
ou créer un nouveau style en cliquant sur < Corps = |
. 7 N . %
+ (plus), situé a droite . =
LEGENDE i
En-téte, bas de page L ;
Note de bas de page
5 3]
|
Etiquette Foncé 1[4
—TH N
Corps 1 - ' Corps 1
R Styles de paragraphe -t T‘ | 5 Styles de paragraphe + E
- Créez un stylej | =
Titre r Titre Pages a créé un nouveau style
Sous-titre j‘ SoLiEe /| quis’appelle Corps 1; jele
En-téte En-téte e modifie en Titre1.
Sous-section 2 — Sous-section 2
Ss-section 3 iﬁ‘ Ss-section 3 B
Sous-section rouge L,, Sous-section rouge
Corps | Corps = |
Corps 1 = Titre1 -
LEGENDE L* : LEGENDE -
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Modification d’un style.

‘ Fages Fichier Edition Insertion m Disposri'ti»on' Présentation ”Pkartager Fenétre Aide

e 006
é 125% - im \
Imprimer  Zoom Tableau Présentation Pol

Titre du documer

Ceci est l'introduction.

c’est le titre 2.

Texte

Tableau
Craphique
Figures et lignes
Image

Vidéo

Copier le style

Coller le style

Ajouter un lien
Supprimer le lien

Avancé

Afficher les polices R8T =
v Gras 3B l Flﬁ ISBE i Q‘m»
> Italique 8l — —
P Souligner ®U Texte
: Barré
Struct
= ructure tre-l =
= Plus grand ®+
'\.SSC Plus petit #®-
(N Ez’ Disposition Plus |
Espacement des caractéres >
%K Ligature > 3
Ligne de base >
; v Aucun 3

C'est maintenant le texte courant justifié.

— Tout en majuscules

L petites majusculf pt|:)
(=8d Casse de titre J

Styles de
caractéres

D)

| Auen |

R

Ici j'ai sélectionné le texte titre du document, qui correspond a Titre1, et je veux lui don-
ner un style petites majuscules.

Texte

TITRE1* -~ R

Style Disposition Plus ’
Police
| Helvetica adl
| Gras ] [ 24pt]2)

ol v & @END

Styles de

3 | Aucun
caractéres

v

Rampe de Lancement 85

Le style de Titre 1 sera:
epetites majuscules;
epolice Helvetica;

een gras;

etaille 24 points;

een rouge.

Pour enregistrer le style modifié, cliquez sur
mettre a jour.

Le document sera mis a jour avec la modifica-
tion du style.
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Enregistrer comme modeéle.

m Edition Insertion Forma

Apres avoir effacé, si nécessaire une partie du

Nouveau... 38N texte, je vais enregistrer le document Pages
¢ Ouvrir... %80 comme modéle.
% Ouvrir un élément récent >
1 N . . 3
= Le modele sera enregistré dans mes modeles et
Tout fermer X #EW oy
A sera affiché au lancement de Pages dans les mod-
Enregistrer 3#S y
1 Enregistrer sous... O3S cles.
7 Renommer...
1 Déplacer vers...
Revenir a =
Exportation vers >
Convertir en Mise en page
: Avancé 3
| Définir le mot de passe...
Enregistrer comme modéle... )
<+ Format d’'impression... 8P
Imprimer... #P
® Pages Fichier Edition Insertion Format Disposition Présentation Partager Fenétre Aide
000 % monmodelel.pages "
Aa A+ a- T ie 1 Ol
Imprimer Zoorm Tableay Présentation Polices Plusigrand Plusopetit Couleurs: Insérer Texte Données multimédias Commentaire Partag Ind cherche
;‘ Créer un modéle Pages personnalisé ? Texte
= f Ajoutez ce document a la liste de modéles ou enregistrez-le sur votre ordinateur.
\ t11j
Annuler Enregistrer... | Ajouter a laliste de modéles
< ";‘;} | Dispcusm-nni Plus

découverte
d'Excel 2011
pour le Mac.

modéle-Rampe1

modéle-rampe85

monmodelel

Rampe de Lancement 85

Pages pour OS X

Ici je vais enregistrer
le document sous le
nom de modéle-
rampe85.
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Création d’une table des

matieres.

Travail préparatoire avant de créer une table des matieres.

Pour insérer une table des matiéres, il faut
que les titres, sous-titres...soient au préal-
able choisis dans votre document; par ex-
emple le titre « création d'une table des
matiéres » sera défini comme style « Titre
1 » et le titre « Travail préparatoire... » sera
défini comme « titre 2 ». Le choix des
styles de titres se fera au fil de lI'eau, c’est-
a-dire quand on saisira le texte (lequel
texte de ce paragraphe s’appelle « Verdana
10 »).

Dans le texte qui suit, « Lille, présentation
générale » a le style « TITREL ».

Verdana

Style

Texte

10 X

Disposition

Plus

Texte

Rampe de Lancement 85

LILLE, PRESENTATION GENERALE.

Lille est une commune du nord de la France, préfecture du département
du Nord et chef-lieu en région Nord-Pas-de-Calais. Surnommée la « Capi-
tale des Flandres », Lille est, avec ses 227 533 habitants au dernier re-
censement de 2011, la principale ville, aux c6tés de Roubaix, Tourcoing et
Villeneuve-d'Ascq, de Lille Métropole Communauté Urbaine!, intercommu-
nalité qui regroupe 85 communes et compte environ 1,2 million d'habita-
nts.

Dans sa partie frangaise, I'unité urbaine de Lille est au quatriéme rang en
France par sa population, avec 1 018 809 habitants au ler janvier 2011,
derriére Paris, Lyon et Marseille, et son aire urbaine est la cinquiéme de
France avec 1 158 306 habitants en 2010.

Plus largement, elle appartient & une vaste conurbation? formée avec les
villes belges de Mouscron, Courtrai, Tournai et Menin® qui a donné nais-
sance en janvier 2008 au premier Groupement européen de coopération
territoriale, I'Eurométropole Lille Kortrijk Tournai, qui totalise
plus de 2 100 000 habitants. Avec les villes de I'ancien
bassin minier du Nord-Pas-de-Ca-
lais, elle participe aussi a un

ensemble mé- tropolitain
de plus de 3,8 mil-
lions d'habitants,
appelé « aire mé-
tropoli- taine de
Lille ».
Son nom en
ancien frangais
(L'Isle),
comme en flamand frangais

(Rysel [ri:sal], et Rijsel* [re1sal] en néerlandais; de « ter Yssel ») pro-
viendrait de sa localisation primitive sur une ile des marécages de la vallée
de la Delle ou elle a été fondée. Lille et ses environs appartiennent a la

TITRE1 &

Styles de paragraphe

Titre

Sous-titre

En-téte

titre2

titre3

Ss-section 3
Sous-section rouge

Corps

LEGENDE

En-téte, bas de page
Note de bas de page

Etiquette Foncé

abm-titre3

“TITRE1

¥ Puces et listes = Aucun
Pas de puces

ocm T
Puce

Retrait :

L —

Pages pour OS X

+

H

2ptC

ocm T

Texte
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2 ' 4 L] 8 10 12 14 16 &v 20 Texte
TITRE1 -
RELIEF ET GEOLOGIE
Disposition Plus
Topographie de la ville de Lille. Police
La ville de Lille est située & environ 20 métres d'altitude3 dans un élargis- Ludloa rando B
sement de la vallée de la Dedle. A cet endroit, les derniers affleurements Griss B sn:
crayeux (Sénonien et Turonien) de la réaion naturelle du Mélantois =
L —— S
Topographie de la ville de Lille. titre2 X
La ville de Lille est située a environ 20 métres d'altitude3 dans un élargis- Styles de paragraphe +
sement de la vallée de la Dellle. A cet endroit, les derniers affleurements =z ¢
crayeux (Sénonien et Turenien) de la région naturelle du Mélantois Titre
plongent a I'ouest sous les Weppes, et, au nord, sous le Bargeul, deux ré-
Sous-titre B
En-téte =
Bpt o
v titre2 S
L — T |

| Relief et Géologie a le style « Titre1 » et Topographie de Lille a le style « titre2 ».

Insertion de la table des matieres.

1 MLECELGLM Format Disposition Présentation Partager Fenétre Aide
Section ‘1 Lille-articlelong1tdm.pages
-~ 1 A- . i v il al

Saut de page #®~ | . : .
s rand Plus petit Couleurs Insérer Texte Données multiméd
| Saut de section L

Saut de colonne

Numéro de page
Nombre de pages
Date et heure

Table des matiéres > Document S

Note de bas de page Section
Jusqu'a la prochaine occurrence

Tahleal
 — —

Une table des matieres se met, en général, en début de document, apres la page de
garde; insérez, si nécessaire un saut de page avant l'insertion de la table de la table
des matiéres puis allez dans le menu insertion > table des matiéres > document
pour insérer une table des matieres pour I'ensemble du document. Vous avez aussi la
possibilité d'insérer d’autres tables des matieres, comme par exemple une table des
matieres pour une section.
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1

Table des matiéres.

La table des matiéres est vide car aucun style de paragraphe défini n’est

utilisé.

Table des matiéres

Sélectionner les styles de paragraphe

affichés dans la table

des matiéres :

Styles de paragraphe n°

titre2
o titre3

Corps

En-téte, bas de page

Note de bas de page

Etiguette Foncé

Intervalle

Tout le document

S

Pages crée la table des matieres, mais il indique ici que les styles de paragraphes
n‘ont pas été définis pour la table des matiéres; rappelons que précédemment nous
avions défini les styles Titres1, titre2 et titre3 comme styles de paragraphes.

Dans le panneau de droite il faudra cochez les styles retenus pour créer la table des

matieres.

Table des matiéres.

Lille, présentation générale.
Géographie.

Relief et géologie
Morphologie urbaine

Voies de communication et transports

Projets d'aménagements

Histoire

Culture et patrimoine
Gastronomie

Personnalités liées a la commune

Table des matiéres

Sélectionner les styles de paragraphe
affichés dans la table des matiéres :

Styles de paragraphe n°

titre2
titre3

Corps

En-téte, bas de page

Note de bas de page

Etiguette Foncé

% TITREL

Intervalle

Tout le document

Nous cochons pour commencer TITREL.
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Table des matiéres.

Lille, présentation générale.
Géographie.

Situation

Relief et géologie

Topographie de la ville de Lille.
Hydrographie

Morphologie urbaine

Tissu urbain

Extensions de la place forte.
Destructions militaires

Voies de communication et transports
Projets d'aménagements
Histoire

Culture et patrimoine
Patrimoine civil

La cité philanthropique
Patrimoine militaire
Patrimoine environnemental
Patrimoine culturel
Gastronomie

Personnalités liées a la commune

© ©O© N N ;O

©o

1
1
13
17
18
20
25
25
27
30
31
32
38
40

Table des matiéres

les styles de
affichés dans la table des matiéres :
Styles de paragraphe n°
R titre2
o ftitre3
Corps

En-téte, bas de page

Note de bas de page

Etiquette Foncé

TITRE1

Intervalle

Tout le document a

Nous cochons

ensuite titre2.

L Table des matidres

Table des matiéres.

Lille, présentation générale.
Géographie.

Situation

Relief et géologie

Topographie de la ville de Lille.
Hydrographie

Morphologie urbaine

Tissu urbain

Extensions de la place forte.
Destructions militaires

Voies de communication et transports
Projets d'aménagements
Toponymie

Histoire

Culture et patrimoine
Patrimoine civil

La cité philanthropique
L'Hospice Comtesse
Patrimoine militaire

La Citadelle.

Patrimoine environnemental
Patrimoine culturel

Théatres et salles de spectacle
Cinéma

Gastronomie

Personnalités liées a la commune

© © N N O

©

1
1
13
17
18
19
20
25
25
27
29
30
30
31
32
34
36
38
40

les styles de
affichés dans la table des matiéres :

Styles de paragraphe n°

<]
<]

titre2
titre3

e ol
1<}

Corps

En-téte, bas de page

Note de bas de page

Etiquette Foncé

<]

TITRE1

Intervalle

©

Tout le document

Et pour terminer nous cochons titre 3; la table des matiéres a été créée.
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Classement des styles dans le panneau des styles.

jertion Format Disposition Présentation Partager Fendtre  Alde WA GN.Cl iy @«

Lie-articielong ! pages
8- Aa | A+ A- O AW~ T - - Ol ® Q

Tatdeas Prisentaton Polces Mus gaand Plus pettt Codeurs insdrer Texts  Dosndes mutenddias Commmentsse Partager  ndces Rectarchn
Lo viwvene --|¢u:a S - BB AN PIBAT e woc‘nn WS R e w Texte
ville. Des remparts qui la ceinturaient du Moyen ﬁge jusqu'au début du
XXe siéclelSS subsistent : titre3* v
la Noble Tour, qul abrite aujourd’hul le mémorial de la déportation, der-
niére trace des 65 tours médiévales qui entouraient la ville (début Xve Sty'es e paragraphe +1
siécle) ;
la porte de Gand et la porte de Roubaix, vestiges de I'ancienne enceinte Titre
espagnole édifiée & partir ce 1621 (début XViie siécle) ;
la porte de Paris, construite en I'honneur de Louls XIV aprés i Sous-titre 2\
conquéte de la ville (in du XV1le siécle) ; ]
des pans de fortifications noyés dans la verdure & I'extrémité de l'ave- En-téte
nue du Peuple belge ; 3 ot 2
la porte de Dunkerque, édifiée & 1a sulte du dernier agrandissement de titre2 "
la ville fortifiée de 1858 (seconde moltié du XIXe siécle).
 titre3
De nombreux édifices militaires ont par ailleurs été reconvertis. C'est le Ss-saction 3
cas notamment de I"ancien corps de garde de la garnison de la ville qui
abrite désormais le thédtre du Nord, de la caserne Squham, dont une par- Sous-section| jge

tie des batiments d'origine est aujourd’hui occupée par le CNRS, de I'anci- -

en « magasin au bled des chitellenies de Lille, Douai et Qrehigs », affecté Corps
a I'Armée au début du XIXe siécle et reconverti en logements d'habitation LEGENDE
au ¢ébut des années 2000156 ou encore de 'hopital militaire, abandonné Enadto
par 'Armée en 1998 et racheté en 1999 par le Ministére de IIntérieur en n-4to, bas do pagy
vue d'y installer les annexes de 1a Préfecture du Nord, Note de bas de page
]
Exiquotte Foncd ]
Y 777 T TigReL L+
o d Aprés ' paragraghe opt -

Styles de paragraphe + Styles de paragraphe -+
Vous pouvez classer les styles
TITRE1 TITRE1 selon vos désirs, il suffit de sélec-
Titre titre2 tionner et de glisser le style.
Sous-titre 7 titre3 Ici le style TITRE1 est glissé vers
En-téte Titre le haut; ce sera ensuite le tour de
titre2 et de titre3.
tijre2 Sous-titre
“ titre3 En-téte
Ss-section 3 Ss-section 3

Sous-section rouge

Corps

LEGENDE

En-téte, bas de page
Note de bas de page

P——
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Sous-section rouge

Corps

LEGENDE

En-téte, bas de page
Note de bas de page

e e

PI——
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